Flame Painter Manual

Version 3.2 Personal | Professional

Einflihrung

Willkommen zu Flame Painter!

Flame Painter ist ein einzigartiges Malprogramm, mit welchem Sie originale Kunstwerke,
Lichteffekte, unkonventionelle Designs oder phantastische Hintergriinde mit Flame Pinseln
ganz einfach kreieren kdnnen.

Es wurde als ein Experimentierprojekt in meiner Serie "l am an Artist" entwickelt. Meine erste
Version sollte ein Programm sein, mit dem jeder etwas Schdnes gestalten konnte. Flame sollte
ein Werkzeug sowohl fir Kinstler als auch fiir Menschen ohne kiinstlerisches Talent sein, die
etwas Einzigartiges gestalten wollen.

Der Mangel an Inspiration ist oft der Grund, warum Menschen nicht kreativ sind - jedoch
kénnen die Werkzeuge, die wir nutzen, eine Quelle der Inspiration sein. Mit jedem Werkzeug,
das inspiriert, kann jeder zum Kiinstler werden. Darum wurde Flame Painter geboren!

Dies ist die dritte Version von Flame Painter. Es sind viele neue Features enthalten: Flame
Painter Connect - ein Photoshop-Plug-in, das als Live-Verbindung zwischen Flame Painter und
Photoshop funktioniert; die Fahigkeit, Wacom-Tablett Druckempfindlichkeit und Leap Motion-
Kamera zu verwenden; ein reibungsloser Import und Export von PSD- und SVG-Vektor-Dateien.
Die Multi-Core-Engine, der neue hochauflésende Renderer und Photoshop-Fillmethoden
haben diese Software zu einem leistungsfahigen Werkzeug fir die Erstellung von
professionellen Kunstwerken gemacht.

Diese Bedienungsanleitung behandelt die Features des Programms und erldutert, was man
alles wissen muss, um mit Flame Painter malen zu kdnnen. Es gibt eine schéne Auswahl an
Pinselparametern - experimentieren Sie mit unterschiedlichen Pinseleinstellungen - und
vielleicht finden Sie einen neuen kreativen Weg der Selbstdarstellung!

Danke, dass Sie Flame Painter erworben haben. Ich hoffe, dass Sie viel Spall beim Malen und
Kreieren haben!

Peter Blaskovic
Entwickler von Flame Painter



Benutzeroberflache

Tools / Werkzeuge

Brush / Pinsel - Wihlt den Pinsel aus
Pen / Stift - Wahlt den reguldren Stift aus
Eraser / Radiergummi - Wahlt den Radiergummi

aus
Fill / Fullen - Wahlt das Fullwerkzeug aus

'@ Flame' @ Follow /v Ribbon

Transform / Transformieren - Verschiebt und
skaliert die ausgewahlte Ebene

Edit Vector Layer / Vektorebene bearbeiten -
Bearbeitungsmodus fiir die ausgewahlte

Blending Normal A4

Opacity N

EEOEREN

Vektorebene
Size 0 E Zoom Out / Auszoomen - Aus dem Bild
span B 4 herauszoomen (bis 5%)

E Zoom In / Einzoomen - In das Bild
Soft hineinzoomen (bis 800%)
Speed Reset Zoom / Zoomfaktor zuriicksetzen -
Center Zoomwert Uberpriifen. Beim Klick auf
Focus diesem Button wird auf 100% gezoomt
Chaos Undo / Riickgangig - Letzten Schritt rlickgangig
. machen

Nose Redo / Wiederholen - Letzte Bildanderung
Eade - ' wiederholen

Detail




Brush / Pinsel
Es stehen drei Malmodi zur Verfligung:

l Flame Flame - Der klassische “Flame” Malmodus

Follow / Verfolgen - Der Pinselstrich verfolgt den Mauszeiger genauer, ein
linienbasierter Pinsel

Ribbon - Der Malmodus “Schleife”, der Strich wird ein bisschen breiter.

Blending / Fiillmethode - Farbfiillmethode. Es stehen drei Farbfillmethoden zur Verfigung:

- Normal fur das Standardmalen,

- Lighten / Aufhellen (additiver Modus) ist typischerweise fur Lichteffekte auf dunklen

Hintergrinden und

- Darken / Abdunkeln (subtraktiver Modus) fiir Lichteffekte auf hellen Hintergrundfarben.

Opacity / Deckkraft - Pinseldeckkraft (0 - 100)

Pinselparameter Flame, Follow und Ribbon
Mit folgenden Pinselparametern konnen Sie experimentieren:

Size / GroRe - Pinseldurchmesser, Anzahl der malenden Pinselpunkte (1 - 300)

Span / Spanne- Pinselbreite (0 - 10)

Dist / Abstand - Pinselpunktabstand (1 - 20) - wahlbar, wenn "Lines" mit "On"aktiviert ist
Soft / Weichheit — Pinselharte (1 - 100), mehr globaler Pinseleffekt

Speed / Geschwindigkeit - Pinselgeschwindigkeit (1 - 100), Reaktionsdauer des Pinsels; je
hoher die Geschwindigkeit, desto praziser der Pinsel

Center / Stdrke - Globale Krafte (0 - 100)

Focus / Fokus - Lokale Krafte (0 - 100)

Chaos / Chaos - Chaos-Parameter (0 - 100) - wie chaotisch Pinselpunkte um einem Pinsel
oszillieren

Noise / Rauschen - Rausch-Parameter (0 - 100), je hoher die Zahl, desto noisier der Pinsel

Alle diese Parameter sind in gegenseitiger Korrelation. Jede Einstellung beeinflusst, wie das
Ergebnis aussehen wird

Fade / Blenden - Ein- und Ausblenden (0 - 10). Einstellen des Blendzeitpunktes

:m Fill | Lines / Fullung | Linien - Wechsel zwischen den Modi "Fill" und "Lines"

Detail - Pinselstrichdetail (1-4). Stellt die Details des Flammenpinselstrichs ein. Hohere Werte
sind fiir weiche Pinselbewegungen, oder wenn das Bild sehr grol8 ist.

Bem.: Es ist ein rechenintensiver Parameter; ein héherer Wert kann zu einer Verlangsamung des
Programm:s fiihren.



Antlallasmg (AA) - Wechsel zwischen "Normal Antialiasing" (Normales Antialiasing)
und "Supersmooth Antialiasing" (Superweiches Antialiasing)

Bem.: Der Parameter "Supersmooth Antialiasing" kann wegen héherer Rechenintensitét zu

einer Verlangsamung des Programms fiihren. Diese Funktion ist nur in der Pro-Edition

erhdiltlich.

Pen / Stift
L B O & X ~ Parameter:
QR B w00 O C Blending / Fiillmethode - Farbfiillmethode. Es stehen

drei Farbfillmethoden zur Verfligung:

- Normal fur das Standardmalen,

Blending (EEEN - Lighten / Aufhellen (additiver Modus) wird

b n = typischerweise fiir Lichteffekte auf dunklen
Hintergrinden und

- Darken / Abdunkeln (subtraktiver Modus) fiir
Tis “ Lichteffekte auf hellen Hintergrundfarben.

Opacity Size / GroRe - Stift-Pinseldurchmesser (1 - 200)
Hardness / Harte - Harte des Stifts (0 - 100)

Step / Schritt - Schritt des reguldren Stifts (0 - 100)
Opacity / Deckkraft - Deckkraft des Pinsel (0 - 100)

Hardness [}

Nutzbar nur mit "Color" (Farbe), "Gradient" (Farbverlauf) ist im Basic Stift Modus nicht
verfligbar.

Eraser / Radiergummi

A2 B e X Parameter:

QQ B f00% ©C Size / GroRe - GroRe des Radiergummis(1 - 200)
Hardness / Harte - Harte des Radiergummis (0 - 100)
Step / Schritt - Schritt des Radiergummis (0 - 100)
Size 48 Opacity / Deckkraft - Deckkraft des Radiergummis
Hardness [ (0-100)

Step

Opacity




AN

Q

Fill / Fiillwerkzeug

Man kann die Ebene mit "Color" (Farbe) oder

"Gradient" (Farbverlauf) fullen. Beim Farbverlauf kann
O] B 100 O C . . . o
man die vertikale oder horizontale Orientierung
einstellen.
~ Vertical ,| Horizontal Vertical |Horizontal - Wechsel zwischen "Vertical" und

"Horizontal" Farbfillung

Transform Layer / Ebene transformieren

Bewegen und skalieren Sie die ausgewahlte Ebene.
Klicken Sie auf OK, um die Anderungen zu akzeptieren,
oder brechen Sie mit Cancel ab.

Wenn Sie die Vektorebene transformieren und
bearbeiten méchten (in der Pro-Edition), klicken Sie
auf die "Edit Vector Layer" - Taste.

Edit Vector Layer / Vektorebene bearbeiten
(Pro Version)

Paint Tool / Malwerkzeug - Neuer Pinselstrich.
Sie kénnen einen Pinselstrich auf eine
Vektorebene malen.

Edit Tool / Bearbeitungswerkzeug -
Schlisselknotenpunkte bearbeiten (gelbe
Punkte), um den Vektor zu mofidizieren. Auf die

grauen Knotenpunkte klicken, um sie in
Schlisselknotenpunkte (gelb) umzuwandeln.

B2t X

Group Edit Tool / Gruppenbearbeitungswerkzeug - Mehrere Schliisselknotenpunkte
bearbeiten (gelbe Punkte).

Add & Remove Tool / Hinzufiigen und Entfernen -Bearbeitbare Knotenpunkte aus der
Flammenlinie entfernen (Tastenkiirzel: Strg oder Ctrl on Windows/Cmd on Mac OS)
Curve Transform / Kurvenbearbeitung - GroRe, Drehung und Skalierung des Pinselstrichs
anpassen.

Init Curve Transform / Anfangskurve anpassen - GroRe, Drehung und Skalierung der
Anfangskurve des Pinselstrichs anpassen.



Vektorebenen besitzen den Vorteil, dass man die gemalten Pinselstriche bearbeiten kann. In
der Vektorebene kann man einen Pinselstrich malen und zusatzlich anpassen. Nach dem
Pinselstrich kann man jeden Pinselparameter, Verlaufsmodus, Deckkraft, Farbe, Farbverldaufe
nachtraglich verandern. Es ist ebenso moglich, andere Pinselvoreinstellungen zuweisen. Es ist
ein sehr flexibler Editiermodus, wenn Sie die Parameter fiir den perfekten Pinselstrich
austesten mochten.

Bem.: Bitte beachten Sie, dass, nachdem Sie einen neuen Strich in einer Vektorebene erzeugen,
der vorherige geléscht wird. Eine neue Vektorebene wird fiir jeden editierbaren Strich
empfohlen.



Palette Panel / Farbfenster

Color | Gradient - Auswahl der Fiillmethode mit einer Farbe oder einem Farbverlauf.

Il Color

Il Color

L!

| Il Gradient

1l Gradient

M Length B

Color / Farbe
Pinselfarbe auswahlen.

H - Farbton (0 - 359)
S - Farbsattigung (0 - 255)
L - Helligkeit (0 - 255)

Palette - Farbe auswahlen
(+) (-) - Farbfeld hinzufligen oder entfernen.

Ein einzelner Mausklick auf einem Farbfeld 6ffnet die
Farbauswahlpalette.

Die Farbe konnte in den Modi Aufhellen (Lighten) oder
Abdunkeln (Darken) sich von der Pinselfarbe
unterscheiden! Besteht der Wunsch nach der exakt
gleichen Farbe, sollte der Malmodus Normal
ausgewahlt werden.

Gradient / Farbverlauf

Wahlen Sie einen Farbverlauf und klicken Sie auf die zu
andernde Farbe unterhalb des Farbverlaufs. Einzelne
Farben des Verlaufs kénnen ein- bzw. ausgeschaltet
werden.

Rotate / Drehen - Farbverlauf drehen
Flip / Spiegeln - Verlaufsiibergang spiegeln

H | S| L-andert Farbton, Sattigung und Helligkeit aller
Farben im Verlauf.

Length / Farbverlaufslange - Wahlen Sie, ob Sie den
Farbverlauf an die Pinselbreite anpassen oder die
Lange des Farbeverlaufs verandern méchten. (1-10)
Je hoher die Zahl, desto haufiger wechseln die
Verlaufsfarben.

(+) (-) - Farbfelder oder Farbverldufe hinzufligen bzw. entfernen.



Brushes Panel / Pinselvoreinstellungen

Die Palette enthalt Pinselvoreinstellungen. Ein Abspeichern eigener Voreinstellungen ist
moglich.
Use palette - Voreinstellung aktivieren.

\ \ A\ | o Use blend mode - Aktiviert Fillmethoden (normal,
@ ‘ lighten oder darken), die im Pinsel gespeichert sind.
4 :
Calligra... Combjelly Feather Share Brush - Laden Sie Ihre Pinseln in die Online
- ? = Brushes Gallery. Klicken Sie auf “Yes” zur Bestatigung.
& ¥
\'6 @ ¢ (2 (+) (-) - Hinzufligen oder Entfernen von
Flame Flamellnes Follow Pinselvoreinstellungen.

Rainbow

Eine neue Pinselvoreinstellung wird durch Anklicken
des (+) gespeichert. Das Icon selbst wird bemalt. Das
Abspeichern erfolgt nach Eingabe des Namens der

Huge Blue Nolse — Pinselvoreinstellung. Diese wird in der Palette sofort

12Y > sichtbar.
%@ o] ,
T = = t‘““ > = Bem.: Wenn Sie den Pinsel im "Abdunkeln" Modus
SUES B?eitd ?v‘lode CRCHES) speichern wollen, steht nur der weifSe Hintergrund zur

Verfiigung. Beim "Aufhellen” Modus ist nur der
schwarze Hintergrund verfiigbar.

Es ist moglich, die neuen Pinsel direkt von der Brushes Webseite nach Flame Painter zu ziehen
und abzulegen (Drag & Drop Funktion). Link zu mehreren kostenlosen Pinseln:
http://www.escapemotions.com/products/flamepainter/brushes/index.php

Bem.: Einige Browser kénnen Pinsel-Metadaten nicht libertragen. Wenn Drag & Drop aus dem
Browser nicht funktioniert, verwenden Sie einen anderen Browser flir die Drag & Drop-Funktion.
Sie kénnen die Pinsel auch aus dem obigen Link zu dem Ordner herunterladen. Den Ordner
finden Sie im Flame Painter Menii: "Help" -> "Show Brushes Folder "->"Brushes". Alle Pinsel, die
sich in der "Brushes" Ordner befinden, werden in der Pinselpanel auch angezeigt.

Die Art und Weise, wie das Drag & Drop funktioniert und wo man die Pinsel herunterladen
kann, finden Sie im FAQ auf unserer Website:
https://www.escapemotions.com/products/flamepainter/support.php.




Layers Panel / Ebenenfenster

Man kann mehrere Ebenen libereinander positionieren und bearbeiten.

Blending / Fiilloptionen - 22 Photoshop Ebenenmodi:
Normal, Darken, Multiply, Color Burn, Linear Burn,

Layers

Blending |Overlay Lighten, Screen, Color Dodge, Linear Dodge, Overlay,
Opacity Soft Light, Hard Light, Vivid Light, Linear Light, Pin Light,
Hard Mix, Difference, Exclusion, Hue, Saturation, Color,
@ My renamed layer 85 Luminosity und Subtract-Modus.
® ™ Lyer : Opacity / Deckkraft - Deckkraft der Ebene (0 - 100%)
@® Layer 1 ' E Eye / Augenicon - Ebene sichtbar oder unsichtbar
machen.
@ Clean Layer - Ebeneninhalt leeren (Tastenkiirzel
Del)
(x) i3 D | Exportto "PS" - Ausgewadhlte Ebene zum

Photoshop exportieren. Sie finden weitere
Informationen zu Flame Painter Connect - das
Photoshop Plug-in nachstehend in diesem
Manual. Diese Option steht nur in der Pro Version
zur Verfligung.

New Layer - Neue Ebene hinzufiigen.

New Vector Layer - Neue bearbeitbare Vektorebene hinzufligen. Diese Option steht nur
in der Pro Version zur Verfligung.

Duplicate Layer - Aktive Ebene(n) duplizieren.

Merge Layers - Mehrere Ebenen auf eine Ebene reduzieren.

Remove Layer - Aktive Ebene(n) I6schen.

GO EEE

Sie kdnnen die aktive Ebene mit einem Doppelklick darauf in der Layer-Liste umbenennen.
In der Menlileiste ist es moglich, die Vektorebene zu Bitmap zu konvertieren.

Die Farb-, Pinsel- und Ebenenfenster sind andockbar - es ist moglich, die Fenster zu
modifizieren, Positionen zu dndern und die Breite anzupassen.



Menu Bar / Mentleiste

File / Datei - enthalt Elemente im Zusammenhang mit Laden, Speichern, Exportieren und
Veroffentlichen lhrer Bilder.

Edit / Bearbeiten - enthilt Elemente im Zusammenhang mit Editierung des Malenprozesses
und Leinwand.

Layer / Ebenen - enthilt Elemente im Zusammenhang mit den Ebenen.

Filter - enthadlt Elemente im Zusammenhang mit der Bildfilterung und den Effekten.

View / Ansicht - enthélt Elemente im Zusammenhang mit dem Ansichtsfenster.

Window - enthdlt Elemente im Zusammenhang mit der Benutzeroberflache.

Help / Hilfe - enthalt Elemente fiir die Anwendungshilfe und Suche nach Updates auf der
Webseite.

File Menu / Datei Menii

New... / Neu... - Erzeugt ein neues Bild mit neuen Einstellungen.

Open... / Offnen... - Offnet ein gespeichertes Bild.

Save / Speichern - Speichert das aktuelle Bild. Wurde das Bild noch nicht gespeichert, wird
nach einem neuen Namen gefragt.

Save As... / Speichern unter... - Speichert das aktuelle Bild mit einem neuen Dateinamen.

Import... / Importieren... - Offnet ein Bild als neue Ebene. Das Bild wird automatisch
entsprechend der aktuellen Bildgrof3e skaliert. Es ist moglich, es in jede GroRe zu bewegen und
zu andern.

Export layer to SVG... - Sie kénnen die aktive Vektorebene als Polygone zum skalierbaren
Vektorgrafikformat exportieren. Setzen Sie die Anzahl der Polygone mit dem Detail-
Schieberegler von 1-4. Diese Option steht nur in der Pro Version zur Verfligung.

Bem.: Wenn die Vektor-Ebene aus 100 000 Polygonen besteht und Details auf 1 gesetzt ist,
rendert und speichert es 100 000 Polygone. Wenn es auf 2 gesetzt ist, vervierfacht es die Anzahl
der Polygone, so dass die Anzahl der Polygone 400 000 ist. Wenn es auf 3 gesetzt ist, ist die
Anzahl 1 600 000. Wenn es auf 4 gesetzt ist, ist die Anzahl der Polygone 6 400 000.

Publish... / Veroffentlichen... - Veroffentlicht hr Kunstwerk in der Flame Painter Galerie online.
Ein Fensterdialog fragt nach dem Namen des Bildes mit der optionalen Angabe einer
Beschreibung und Stichwortern.

Publish Preferences... / Voreinstellungen veroffentlichen - Ein Untermen( mit Galerie-
Voreinstellungen.

Preferences... / Voreinstellungen... - Safe Boundary, Wacom Tablet and Leap Motion-
Praferenzen einstellen.



- Safe Boundary - Sie kénnen eine erweiterte Arbeitsflaiche mit mehr sichtbarem Platz als die
LeinwandgrolRe festlegen. Sie kdnnen die Sichtbarkeit ein-und ausschalten und die Grof3e und
Deckkraft des sicheren Rahmens einstellen.

- Wacom Tablet - Einstellungen fir die Arbeit mit Tablets, die Stiftdruck-Empfindlichkeit
unterstiitzen. Sie kénnen die Intensitat der Parameter einstellen, die von dem Stiftdruck
beeinflusst sind.

- Leap Motion - Einstellungen fiir Leap Motion-Controller. Es ermoglicht Malerei mit der
Verwendung der Bewegungssteuerung einer Hand. Wahlen Sie Shift-Key, um mit einem Finger
zu malen und nutzen Sie die "Shift"-Taste als Maustaste; oder wahlen Sie Show Two Fingers,
um mit zwei Fingern zu malen.

Quit / Beenden - Flame Painter schlieRen.

Siehe auch Kapitel ,,Erzeugen, Offnen und Speichern von Bildern®.

Edit Menu / Bearbeiten Menii

Undo / Riickgédngig - Letzte(n) Schritt(e) riickgdangig machen. Die maximale Anzahl an
rickgangigen-Schritten ist abhangig von der Speichergrofie Ihres Computers und betragt
maximal 100 Riickgangig-Schritte.

Redo / Wiederholen - Letzten Schritt wiederholen.

Image Size... / GroRe des Bildes... - Ein Untermen( enthélt Breite, Hohe des verdnderten Bildes
in Pixel und sicherer Rahmen (Arbeitsflache) in Prozent.

Beispiel: Wenn Sie ein Bild mit der Gréf3e 1200 x 1200 Pixel und sicherem Rahmen auf 10%
gesetzt erstellen, betrégt die GréfSe des sicheren Rahmens 120 Pixel.

Wahlen Sie Keep Aspect Ratio (Seitenverhaltnis beibehalten), wenn Sie das Bild im gleichen
Seitenverhaltnis wie das aktuelle Bild andern méchten.

Beispiel: Wenn die aktuelle Bildbreite 1200 Pixel und Héhe 800 Pixel ist und Sie wollen die
Bildbreite zu 2400 Pixel mit dem gleichen Seitenverhdltnis éndern, schalten Sie Keep Aspect
Ratio ein. Die Applikation wird die verbleibende Dimension berechnen. (2400 x 1600 Pixel)

Bem.: Bitte versichern Sie sich, daf3 Sie Ihr Kunstwerk gespeichert haben, bevor Sie die Bildgréfie
dndern. Undo nach der BildgréfSendinderung ist nicht verfiigbar.

Copy / Kopieren - Kopieren Sie die Ebene in oder aus einer dritten Partei Anwendung, die
Bilder mit Alpha-Kanal in der Zwischenablage unterstitzt.

Paste / Einfligen - Fligen Sie die Ebene in oder aus einer dritten Partei Anwendung ein, die ein
Bilder mit Alpha-Kanal in der Zwischenablage unterstitzt.

Sie kénnen ein Bild aus Applikationen oder Internet Browser auch direkt in Flame Painter 3
ziehen und ablegen (Drag & Drop Funktion), sofern die Applikation dies erlaubt.

Folgende Werkzeuge arbeiten nur mit Vektorebenen, sonst sind diese Optionen ausgegraut.
Diese Funktionen sind in der Pro-Edition erhdiltlich.



Paint Tool / Malwerkzeug - Malen Sie einen neuen Pinselstrich. Sie kbnnen einen Pinselstrich
auf eine Vektorebene malen.

Edit Tool / Bearbeitenwerkzeug - Bearbeiten Sie Haupteckpunkte (gelbe Punkte) und dndern
Sie den erstellten Vektor. Klicken Sie auf die Eckpunte (grau), um sie in Haupteckpunkte (gelb)
umzuwandeln.

Group Edit Tool / Gruppenbearbeitung - Die Gruppe der Haupteckpunkte bearbeiten (gelbe
Punkte)

Add & Remove Tool / Hinzufiigen und Entfernwerkzeug - Editierbare Eckpunte von der Flame-
linie entfernen (Tastenkirzel: STRG fir Win, Cmd fir Mac OS)

Curve Transform / Kurvenbearbeitung - Pinselstrich vergroRern, verkleinern, drehen und
skalieren.

Init Curve Transform / Anfangskurve anpassen - Anfangskurve fur Pinselstrich vergréRern,
verkleinern, drehen und skalieren.

Layer Menu / Ebenenmenii

New Layer / Neue Ebene - Neue Ebene hinzufugen.

New Vector Layer / Neue Vektorebene - Neue Vektorebene hinzufligen. (nur Pro Edition)
Duplicate Layer / Ebene duplizieren - Aktive Ebene(n) duplizieren.

Merge Layers / Ebenen reduzieren - Ebenen in eine Ebene reduzieren

Delete Layer / Ebene l6schen - Aktive Ebene(n) I6schen.

Show Layer / Ebene anzeigen - Aktive Ebene verstecken oder zeigen.
Transform Layer / Ebene transformieren - Aktive Ebene verschieben und skalieren.
Clear Layer / Ebene leeren - Ebeneninhalt leeren.

Export to Photoshop / Zu Photoshop exportieren - Die Ebene mit Ebeneneinstellungen,
Blending-Modus und Opazitat (Deckkraft) aus Flame Painter zu Photoshop exportieren.

Sie finden weitere Informationen zu Flame Painter Connect - das Photoshop Plug-in - weiter
untenstehend in diesem Manual.

Convert to bitmap / Zu Bitmap konvertieren - Vektorebene zu Bitmapebene konvertieren (nur
Pro Edition)

HiRes render... - Das Detail von High Resolution Renderer einstellen (1 - 5). Der HiRes-Renderer
ist ein polygonaler Renderer. Er fillt den Raum zwischen Punkten und macht das Bild glatter
ohne das Auftreten von Moiré-Artefakten. Dies kann nur beim Malen mit Vektorebenen
verwendet werden.

Wenn das HiRes Rendern abgeschlossen ist, ersetzt das gerenderte Bild die aktuelle Ebene.
"HQ" erscheint im Fenster und bedeutet "hohe Qualitit". Wenn Sie weitere Anderungen an der
gerenderten Vektorebene machen, verschwindet das "HQ" und die Vektorebene muss neu
gerendert werden.

Driicken Sie die Esc-Taste, um das Rendering abzubrechen. Bitte warten Sie, bis der Prozess
beendet ist. (nur Pro Edition)



Bem.: HiRes-Renderer ist sehr rechenintensiv. Es kann eine Vektorebene noch einige Stunden
rendern. Die Render-Zeit ist stark abhéngig von der Pinselléinge sowie den "Gréf3e" -Parameter-
einstellungen. Je gréfSer Pinselstrich und Gréf3e sind, desto Idnger dauert es, um zu rendern.

Beispiel: Wenn die Vektor-Ebene aus 100 000 Polygonen besteht und das Detail des HiRes-
Renderers auf 1 gesetzt ist, kann es 1 Minute rendern.Wenn es auf 2 eingestellt ist, vervierfacht
es die Anzahl der Polygone, so dass die Anzahl der Polygone 400 000 ist, und es rendert die
Ebene ca. 4 Minuten. Wenn es auf 3 gesetzt ist, wird die Anzahl 1 600 000 und die Zeit ca. 16
Minuten. Wenn es auf 4 gesetzt ist, wird die Anzahl 6 400 000 und die Zeit ca. 64 Minuten.
Wenn es auf 5 gesetzt ist, wird die Nummer 25 600 000, und die Zeit wird 256 Minuten, ca. 4
Stunden.

Filter Menu / Filter Menii

Blur / Unschiarfe - Unscharfe-Radius in einem Pop-up-Fenster einstellen
- Preview / Vorschau - das Ergebnis in Echtzeit anzeigen oder verstecken
Glow / Gliithen - Radius und Starke des Glihens in einem Pop-up-Fenster einstellen
- Preview / Vorschau - das Ergebnis in Echtzeit anzeigen oder verstecken

Tile Layer / Kachelebene - Kachelt die Ebene (horizontal und vertikal)

View Menu / Ansicht Mentii

Zoom In / Einzoomen - In das Bild hineinzoomen (bis 800%).
Zoom Out / Auszoomen - Aus dem Bild herauszoomen (bis 5%)
Zoom 100% - Uberpriift den Zoomwert. Beim Click auf diesem Button wird auf 100% gezoomt

Show Cursor / Mauszeiger anzeigen - Mauszeiger anzeigen oder verstecken
Show Brush Dots / Pinselpunkte anzeigen - Pinselpunkte anzeigen oder verstecken

Window Menu / Fenster Menii

Tools / Werkzeuge - Werkzeugefenster anzeigen oder verstecken
Palette / Farbfenster - Farbfenster anzeigen oder verstecken
Brushes / Pinsel - Pinselvoreinstellungen anzeigen oder verstecken
Layer / Ebenen - Ebenenfenster anzeigen oder verstecken

Stay on Top / Im Vordergrund bleiben - Die Applikation bleibt immer im Vordergrund vor
anderen Applikationen.

Fullscreen - Stellt auf volle BildschirmgréRe um (klicke Esc, um Fullscreen zu schliel3en).
Presentation mode / Presentationmalmodus - Fullscreen Malmodus ohne Mentleiste (klicke
Esc, um zu schlieBen)



Help Menu / Hilfe

Help / Hilfe - Offnet das Hilfedokument (in Englisch)

Send Feedback... / Feedback senden... - Schicken Sie uns Ihr Feedback, wenn Sie irgendwelche
Probleme oder Ideen haben, oder wenn das Program lhnen gefallt. Bitte geben Sie Ihre Email-
Adresse und Nachricht ein und klicken dann auf Send.

Flame Painter Website - Link auf die Webseite:
www.escapemotions.com/products/flamepainter

About Flame Painter / Uber Flame Painter - Weitere Informationen tiber Flame Painter,
Copyright und Danksagungen.

Show Brushes Folder / Brushes Ordner zeigen - Den Ordner zeigen wo die Pinsel gespeichert
sind.

Check for updates... / Updates priifen - Dieser Button ist sichtbar, wenn neue Updates
verflgbar sind.

Upgrade to Pro edition / Upgrade zu Pro Edition - Klicken Sie hier, wenn Sie von der Personal
auf die Pro Edition upgraden mochten. (Nur Personal Edition)



Flame Painter Connect

Flame Painter Connect ist ein Plug-in fiir Photoshop CS5, CS5.5, CS6 und Photoshop CC. Es ist
ein Live-Kommunikationskanal zwischen Photoshop und Flame Painter 3 Pro fiir den Austausch
von Ebenen.

Installation

Ihr Installationspaket enthdlt 3 Ordner:

Mac OS
Windows
Photoshop plugin

Installation fiir Photoshop CS5 & CS5.5

Kopieren Sie "Flame_Painter_Connect.swf"-Datei aus dem “Photoshop plugin”-Ordner in den
Photoshop-Installationsordner:

- Windows 32bit: C:\Program Files (x86)\Adobe\Adobe Photoshop CS5\Plug-ins\Panels\
- Windows 64bit: C:\Program Files\Adobe\Adobe Photoshop CS5 (64 Bit)\Plug-ins\Panels\
- Mac OS: /Applications/Adobe Photoshop CS5/Plug-ins/Panels/

Installation fiir Photoshop CS6 & CC

Schritt 1: Offnen Sie den “Photoshop plugin”-Ordner und doppelklicken auf
"Flame_Painter_Connect_1.2.zxp"-Datei. Wenn die Datei nicht automatisch mit Extension
Manager verbunden ist, 6ffnen Sie Ihren Extension Manager, und wahlen Sie aus dem Meni:
File -> Install Extension.

Schritt 2: Das Fenster “Extension Disclaimer” 6ffnet sich - klicken Sie auf “Accept”.

Schritt 3: Ein Fenster 6ffnet sich mit der Meldung, dass ein Publisher nicht verifiziert werden
kann - klicken Sie “Install”.

Schritt 4: Falls Sie weitere Adobe-Produkte und Erweiterungen auf lhrem Computer installiert
haben, 6ffnet sich ein neues Fenster und erfragt, in welcher Photoshop Version Sie ein Plug-in
installieren mochten.

Falls Extension Manager nicht auf lhrem System installiert ist, oder die Pugininstallation nicht
glltig ist, kopieren Sie manuell die "Flame_Painter_Connect.swf"-Datei in den Photoshop-
Installationsordner:

- Windows 32bit: C:\Program Files (x86)\Adobe\Adobe Photoshop CS6\Plug-ins\Panels\
- Windows 64bit: C:\Program Files\Adobe\Adobe Photoshop CS6 (64 Bit)\Plug-ins\Panels\



- Mac OS: /Applications/Adobe Photoshop CS6/Plug-ins/Panels/

Flame Painter Connect Initialisierung

Schritt 1: Lassen Sie Photoshop und Flame Painter 3
parallel laufen.

Schritt 2: Erstellen Sie in Photoshop ein neues
Dokument im Menu: File -> New...

Schritt 3: In Photoshop klicken Sie auf Menl: Window
—> Extensions —> Flame Painter Connect. Ein neues
Flame Painter Connect - Panel erscheint an der
rechten Seite des Bildschirms.

Ebenen exportieren

Export aus Photoshop zu Flame Painter

Wahlen Sie eine Ebene in Photoshop, die Sie zu Flame Painter exportieren méchten. Klicken Sie
auf den "PS to FP"-Button. Wenn Sie eine leere Ebene in Flame Painter auswahlen, wird eine
Ebene aus Photoshop in diese leere Ebene exportiert, anderenfalls wird eine neue Ebene
erstellt.

Export aus Flame Painter zu Photoshop

Wahlen Sie eine Ebene, die Sie zu Photoshop exportieren mochten und klicken Sie auf Men:
Layer —> Export to Photoshop (Tastenktrzel: Ctrl-F fiir Windows, Cmd-F fir Mac OS). Wenn
Sie eine leere Ebene in Photoshop auswahlen, wird eine Ebene aus Flame Painter in diese leere
Ebene exportiert, anderenfalls wird eine neue Ebene erstellt.

Exportierte Ebenen halten ihre urspringlichen Namen und Deckkraft. Die meisten
Blendingmodi kopieren ihre urspriinglichen Voreinstellungen auch.

Bem.: Folgende Mdglichkeit muB im Photoshop DESELEKTIERT sein: Edit --> Preferences -->
Interface --> Auto-Collapse lkonpanels.

Wenn es selektiert ist und Sie schalten auf Flame Painter um, um die Ebene zu exportieren,
schliesst sich das Flame Painter Connect-Panel. Wenn das Flame Painter Connect-Panel



geschlossen wird, funktioniert die Ebenentibertragung zu Photoshop nicht. Das bedeutet, dass
das Flame Painter Connect-Panel wihrend des Exports immer sichtbar sein mu@.

Die gleiche LeinwandgroBe in Photoshop und Flame Painter beibehalten

Moglichkeit 1: Lassen Sie Photoshop laufen.
Wenn Sie die Photoshopebene zu Flame Painter exportieren méchten,
offnet sich Flame Painter mit der exportierten EbenengroRe.

Moglichkeit 2: Lassen Sie beide Photoshop und Flame Painter 3 laufen.
Wenn Sie die Photoshopebene zu Flame Painter exportieren méchten und
ein neues Dokument ohne vorherige Anderungen in Flame Painter gedffnet
ist, wird das neue Dokument entsprechend der exportieren Ebenengrésse
skaliert.

Moglichkeit 3: Lassen Sie beide Photoshop und Flame Painter 3 laufen.
Offnen Sie Flame Painter Connect in Photoshop. Wenn Sie die Ebene aus
Flame Painter exportieren, wird das neue Dokument in Photoshop mit der
exportierten Ebenengrofie erstellt.

Moglichkeit 4: Sie kdnnen die gleiche LeinwandgrolRe in beiden Applikationen manuell
einstellen.

Bem.: Falls die folgende Meldung wéihrend der Arbeit mit Flame Painter Connect erscheint,
liberpriifen Sie, ob beide Flame Painter und Photoshop laufen.

r x
Flame Painter 3 P M

@ It seems that Photoshop or Flame Painter Connect is not running.

Ensure that Photoshop is running on your system
and Flame Painter Conneckt plug-in is installed and running in Photoshop.

Wenn alles richtig eingestellt ist, knnte diese Meldung beim Exportieren aus Photoshop
erscheinen und bedeutet, dass es zu lang fiir Photoshop dauert, um die Anforderung zu
verarbeiten. Klicken Sie auf "OK" und warten Sie einige Sekunden, bis das exportierte Bild in
Flame Painter angezeigt wird.



Erzeugen, Offnen und Speichern von Bildern

Ein neues Bild erzeugen

Uber den Meniipunkt File -> New... oder STRG+N wird ein neues Bild erzeugt. Ein Dialogfenster
erscheint, in welchem man die BildgréRe und weitere Einstellungen angeben kann. Die Grofe
kann jederzeit beim Malen verandert sein. “Picture Size Info” gibt die DruckgrofRe des Bildes an.

Mit dem Farbbutton Color kann man die Hintergrundfarbe auswahlen einschliesslich der
Voreinstellung schwarzer oder weisser Hintergrund.

Bestatigen Sie die Eingaben mit OK oder verwerfen diese mit Cancel.

Ein Bild 6ffnen

Uber den Meniipunkt File -> Open... oder STRG+O 6ffnet man ein bestehendes Bild in Flame
Painter. Zusatzlich kdnnen die Eigenschaften des Bildes angepasst werden.

Offnen Sie das Bild mit OK oder brechen Sie mit Cancel ab.

Sie kdnnen das Bild auch direkt aus einer beliebigen Quelle ziehen und ablegen (Drag and Drop
Funktion) - aus Ordnern, Browser oder Websites. Es 6ffnet sich als eine neue Ebene.

Ein Bild speichern

Uber die Meniipunkte File -> Save... und File -> Save As... speichert man das Bild auf der
Festplatte. Flame Painter nutzt ein eigenes Dateiformat mit der Endung FPA. In dieser Datei
sind alle Informationen des Bildes und der Ebenen enthalten. Nutzen Sie dieses Dateiformat,
wenn Sie spater an einem bestehenden Bild weiterarbeiten mochten.

Mit Flame Painter 3 Pro kdnnen Sie PSD-Dateien fiir Photoshop, Gimp oder andere Bitmap-
Programme mit PSD-Dateiformatunterstitzung offnen und speichern - mit allen
Ebeneneinstellungen, Fillmethoden (Blending Modes) und Deckkraft (Opazitat). Es ist moglich,
die Vektorebenen als SVG-Vektor-Format-Datei in lllustrator oder andere Vektorgrafik-
Editoren zu exportieren. Dort kdnnen Sie kontinuierlich |hr Flame-Bild in Vektoren bearbeiten.

Weitere Dateiformate stehen zur Verfligung, jedoch werden Detailinformationen nicht mit
abgespeichert. Achten Sie darauf, dass sich die Hintergrundfarbe eventuell dndern kénnte.
Beispielsweise werden Transparenzinformationen nicht im JPEG-Format abgespeichert.

Wenn das Bild mit spezifischen Einstellungen oder fiir andere Programme lesbar abgespeichert
werden sollen, nutzen Sie die Save As... Funktion tGber den Menilpunkt. Das Bild lasst sich in

den Formaten PSD, PNG, TGA, TIF, BMP oder JPG abspeichern.

Speichern Sie das Bild mit OK oder brechen Sie mit Cancel ab.



Veroffentlichen eigener Werke in der Online-
Galerie

Galerie-Konto erzeugen

Um eigene Werke zu veroffentlichen, ist ein eigenes Konto erforderlich. Anbei die
Beschreibung zweier Vorgehensweisen:

Aus Flame Painter heraus:
Konto iber den Menlpunkt File -> Publish Preferences erzeugen. Geben Sie lhren Namen, E-
Mail (“Your ID”) und Passwort ein. Optional ist die Angabe Ihrer eigenen Webseite.

Auf der Webseite:

Auf der Gallery Webseite loggen Sie sich liber Login -> Create Account ein und geben lhre
“Your ID” (lhre Registrierungs-E-Mail) an. Sie erhalten per E-Mail ein Passwort zugeschickt.
Bem.: "Your ID" wird im Programmmenu Help -> About Flame Painter angezeigt. Sollte "Your
ID" nicht existieren, geben Sie lhre aktuelle E-Mail-Adresse ein.

Veroffentlichen eigener Werke

Um ein eigenes Kunstwerk in der Galerie zu veréffentlichen, nutzen Sie den Menipunkt File ->
Publish... Geben Sie |hrem Werk einen Namen (Artwork Name), eine Beschreibung
(Description) und Stichworter (Tags). Durch das Klicken des Publish Buttons wird lhr Bild auf
der Gallery Webseite (www.escapemotions.com/gallery) veroffentlicht. Die Bilder dort kdnnen
auch nachtraglich weiter bearbeitet werden.

Galerieprofil und Bilder bearbeiten

Gehen Sie auf die Gallery Website, loggen Sie sich Uber Login ein und geben "Your ID" und
Password an.

Im Bereich Edit Pictures kdnnen u. a. Namen, Beschreibungen und Stichworter bearbeitet
werden.

Im Bereich My Profile kann das Passwort geandert werden.



Tastenklirzel:

Windows
New... / Neu... STRG+N
Open... / Offnen... STRG+O
Save / Speichern STRG+S

Save As... / Speichern unter...

STRG+Shift-S

Import... STRG+Shift+0
Publish... / Veréffentlichen... STRG+P
Quit / Beenden STRG+W
Undo / Rickgangig STRG+Z

Redo / Wiederholen STRG+Shift+Z
Copy / Kopieren Ctrl+C

Paste / Einflgen Ctrl+v

Export to Photoshop Ctrl+F

Brush / Pinsel

Pen Brush / Stift Pinsel
Eraser / Radiergummi

Fill / Flllwerkzeug
Transform / Transformieren

Edit Vector Layer / Vektorebene bearbeiten

Increase Value +1 / Wert um 1 vergroBern
Decrease Value -1 / Wert um 1 verringern
Increase Value +10 / Wert um 10 vergroRern

< —H4Tmm>»pO

Bild auf

Decrease Value -10 / Wert um 10 verringen Bild ab

Clean Layer / Ebene leeren

Move Canvas / Leinwand bewegen

Del

Pfeil nach oben
Pfeil nach unten

Mac OS

Cmd+N
Cmd+0O
Cmd+S
Cmd-Shift+S
Cmd+Shift+O
Cmd+P
Cmd+Q

Cmd+Z
Cmd-Shift+Z
Cmd+C
Cmd+V
Cmd+F

Rechte Maustaste oder Leertaste+ Linke Maustaste

Zoom In / Einzoomen STRG +
Zoom Out / Auszoomen STRG -
Zoom 100% STRG +0
Zoom In | Out - Ein-/Auszoomen Mausrad
Safe Boundary / Sicherer Rahmen STRG+B

Cursor Show | Hide - Mauszeiger anzeigen/verstecken
Brush Dots Show | Hide - Pinselpunkte anzeigen/verstecken

Quit HiRes Rendering / HiRes Rendering beenden

Fullscreen / Vollbildmodus STRG +L
Show Main Menu / Hauptmeni anzeigen STRG+ M
Help / Hilfe F1

Paint Tool / Malwerkzeug

Edit Tool / Bearbeitenwerkzeug

Group Edit Tool / Gruppenbearbeitung

Add & Remove Tool / Hinzufigen und Entfernwerkzeug
Curve Transform / Kurvenbearbeitung

Init Curve Transform / Anfangskurve anpassen

Alt+C
Alt+D

Esc

U WN R

Cmd +
Cmd -
Cmd-0
Mausrad

Cmd+B

Cmd + L
Cmd+ M
Cmd+?



Personal versus Professional Version

Personal Version eignet sich fir die Anwender, die eine komplette Kreativitatsversion
mochten, aber nicht die erweiterten Funktionen bendtigen. Zusatzlich ist es den Benutzern
dieser Version nicht erlaubt, Bilder zu verkaufen, die mit Flame Painter bearbeitet oder erzeugt
wurden. Diese Lizenz erlaubt die Installation von Flame Painter auf mehreren Rechnern eines
Benutzers und die Nutzung des Programms fiir nichtkommerzielle Zwecke.

Professional Version ist fiir die fortgeschrittenen Benutzer gedacht, die mit den erweiterten
Funktionen, wie Vektorebenen, HiRes Renderer oder Photoshop-Verbindung, arbeiten
mochten. Diese Lizenz erlaubt die Installation von Flame Painter auf einem einzigen Rechner
fur Firmen oder auf mehrere Rechner eines Benutzers. Diese Lizenz kann fiir kommerzielle
Zwecke oder Profitaktivitaten sowie fiir nichtkommerzielle Zwecke genutzt werden.

Weitere Details finden Sie in der vollstandigen “Software License Agreement” in englischer
Sprache.



Copyright & Danksagungen

Flame Painter © 2012 - 2014 Escape Motions, s.r.o.
Flame Painter © 2009 - 2012 Peter Blaskovi¢
Flame Painter Connect © 2014 Escape Motions, s.r.o.

Flame Painter Team:
Peter Blaskovi¢, Michal FapS$o, Veronika Klimekova, Andrea Vachova
Unser besonderer Dank geht an:

Alle, die mit Ideen, Anregungen beigetragen, oder Flame Painter zu finalisieren geholfen
haben, insbesondere Jozef Bardik, Matus Fedorko, Daniel Kapi¢dk, Jaroslav Kasa, Rastislav
Piovarci, Rastislav Hornak, Gabika Ambrusova, Cara, Daniel Innes, Oto Kéna, Tomas Lancz,
Lukas Lancz, Tomas MisSura, Andrei Oprinca, Martin Surovéek, Roman Urbasek, Harvey Bunda,
Rana Diaz, Devraj Baruah, Dennis Kirkpatrick, Jim Kanter, Gregorii Trombo, Keith Alford, Josh
Kitney, Nigel Brewster, Vladimir Chopine, Mark S. Johnson.

Ubersetzungen und Korrekturen: Tanya Hayman, Tony Lloyd, Daniel Streidt, Kenjiro Nagano,
Higashiuchi Takuri, Kévin Jorand, Marta Fernandez, Irene Briz, Andy Chen, Elke Schnabel,
Veronika Klimekov3a, Andrea Vachova

User Interface Icons / Benutzeroberfliache Ikonen: "Batch" by Adam Whitcroft

Libraries / Bibliotheken:

Diese Applikation ist mit den folgenden Bibliotheken entwickelt worden:

Qt 4.8 - LGPL license (2.1) - http://qt-project.org/downloads/

QuaZIP - LGPL license (2.1) - http://sourceforge.net/projects/quazip/

CryptoPP - Boost Software License (1.0) - http://www.cryptopp.com/

ImageMagick, Apache license - http://www.imagemagick.org/

AntiGrain Geometry 2.4, LGPL license - http://agg.sourceforge.net/antigrain.com/index.html
MB WebSockets, LGPL license - https://qt.gitorious.org/qtplayground/mbwebsockets

Danke Gott fur all die vielen kreativen Ideen.



Flame Painter End-User Software License Agreement

Copyright 2012 - 2014 Escape Motions, s.r.o. All Rights Reserved.
Copyright 2009 - 2012 Peter Blaskovic. All Rights Reserved.

This license is a legal agreement between you and Escape Motions for the use of Flame Painter
software (the "Software"). By downloading, installing, copying, or otherwise using the
Software, you acknowledge that you have read terms and conditions of this license,
understand them, and agree to be bound by them. If you do not agree with these terms and
conditions, Escape Motions is unwilling to license the Software to you, and you are not
authorized and may not use the Software.

Permitted Use
Flame Painter Personal:

Users of the Flame Painter may use the Software for personal, non-commercial, or non-profit
activities.

You may install the Software on multiple computers provided that not more than one of those
computers is in use simultaneously and that those computers are solely for your own personal
use.

Flame Painter Professional:

Users of the Flame Painter may use the Software for commercial, or for-profit activities as well
as for personal, non-commercial, or non-profit activities.

The Software may be installed on a computer that is for multiple users but it may not be
installed on more than one computer regardless of whether those computers are operated
simultaneously or not.

You may install the Software on multiple computers provided that not more than one of those
computers is in use simultaneously and that those computers are solely for your own personal
use.

You may not remove the copyrights notices from the Software. You may make one (1) copy of
the Software for back-up or archival purposes.

Restrictions

This is a SINGLE COPY SOFTWARE LICENSE. The Software is copyrighted and protected by law
and international treaty. This is a license, not a transfer of title, and unless you have been
granted prior, written consent from Escape Motions you may not:

a, Reproduce, distribute, or transfer the Software, or portions thereof, to any third party.

b, Sell, rent, lease, assign, or sublet the Software or portions thereof.



¢, Grant rights to any other person.

d, Modify, decompile, reverse engineer, disassemble, or create derivative works based on the
Software or the documentation in whole or in part.

e, Use the Software in violation of any international law or regulation.

You must not intentionally or unintentionally make the Software available on any web server,
ftp server, file sharing network, shared directory, or other location where any other person can
acquire a copy of the Software. You are responsible for keeping the Software safe from being
copied by others.

Display of Copyright Notices

All copyright and proprietary notices and logos within the Software files must remain intact.

Indemnity

You agree to indemnify and hold harmless Escape Motions for any third-party claims, actions or
suits, as well as any related expenses, liabilities, damages, settlements or fees arising from your
use or misuse of the Software, or a violation of any terms of this license.

The Software may contain technical inaccuracies or typographical errors, so changes and/or
updates may be affected without notice.

Peter Blaskovic may also make improvements and/or other changes to the Software at any
time without notice.

Disclaimer Of Warranty

THE SOFTWARE IS PROVIDED \"AS IS\", WITHOUT WARRANTY OF ANY KIND, EXPRESSED OR
IMPLIED, AS TO THE SOFTWARE OR ITS OPERATION, INCLUDING, BUT NOT LIMITED TO,
WARRANTIES OF QUALITY, PERFORMANCE, NON-INFRINGEMENT, MERCHANTABILITY, OR
FITNESS FOR A PARTICULAR PURPOSE. FURTHER, PETER BLASKOVIC DOES NOT WARRANT THAT
THE SOFTWARE OR ANY RELATED SERVICE WILL ALWAYS BE AVAILABLE.

Limitations Of Liability

YOU ASSUME ALL RISK ASSOCIATED WITH THE INSTALLATION AND USE OF THE SOFTWARE. IN
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS OF THE SOFTWARE BE LIABLE FOR
CLAIMS, DAMAGES OR OTHER LIABILITY ARISING FROM, OUT OF, OR IN CONNECTION WITH
THE SOFTWARE. LICENSE HOLDERS ARE SOLELY RESPONSIBLE FOR DETERMINING THE
APPROPRIATENESS OF USE AND ASSUME ALL RISKS ASSOCIATED WITH ITS USE, INCLUDING
BUT NOT LIMITED TO THE RISKS OF PROGRAM ERRORS, DAMAGE TO EQUIPMENT, ANY LOST
PROFITS, BUSINESS INTERRUPTION, LOSS OF DATA OR SOFTWARE PROGRAMS, OR
UNAVAILABILITY OR INTERRUPTION OF OPERATIONS.



